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LESSON 1 -  
EXPLORING NEW INTERFACE CHANGES  
 

EXPLORING WINDOWS XP 

 Discussion 
Windows XP is Microsoft’s new operating system for the personal computer. XP stands for 
eXPerience; experience that comes from all the previous versions of Windows. 
 
Former versions of the Windows operating system for personal computers belonged to one of two 
categories. The first category included Windows 95, 98 and Windows Me. These versions targeted 
the consumer market and were inherently unstable. The other category was aimed at the 
professional/corporate market, and was known as Windows NT. Previous NT versions include 3.1, 
3.5, 3.51, 4.0 and Windows 2000. NT, while more limited in compatible hardware and software, 
provided a much more stable environment than Windows 9.x. Windows XP was created to meet the 
demands of both the consumer and corporate marketplace. 
 
There are two versions of Windows XP, the Home Edition and the Professional Edition. The 
Professional Edition incorporates all the features of the Home Edition with additional features for 
connecting to corporate networks and domains, and features for accessing office resources from 
remote locations. 
 
In both versions, Windows XP has taken the complexity out of setting up your computer by 
including more wizards for connecting to printers, networks, and the Internet, and for performing 
various system and administrative functions. There are even wizards to help you send files to a Web 
server or your own Web site, print photos, and remove unused items from your desktop. 
 
Microsoft has designed Windows XP with a fresh, new interface that is simpler in design and easier 
to use. Windows XP provides a context-sensitive environment; sensing your current setting and 
presenting the most commonly used tasks. In addition, user tasks are grouped into logical, 
hierarchical categories for easier access. 
 

LOGGING INTO WINDOWS XP 

 Discussion 
Windows XP is a secure operating system, meaning that users must log into their local “workstation” 
in order to gain access to the computer. You can no longer hjt the “Cancel” button to bypass the 
login screen. When you start Windows XP, the login screen that you see will depend on whether or 
not you are a member of the Arts & Science domain. While A&S is using a Windows domain for its 
networking, the rest of the campus is still using Novell networking software. 



 

Page 2 UNiversity Informational Technologies (UNIT) 
 

 
For those logging into the Arts & Science domain (this includes everyone in SAC and a few other 

departments around campus), you will need to hit the Ctrl-Alt-Del key combination on your 
keyboard in order to get the login box below. Make sure that you are logging into the ASDOMAIN. 
Your username should be filled in already. Simply type in your LDAP (email) password in the 
password box and click OK. 

 
IMPORTANT NOTE: if you are a member of the Arts & Science domain, do not log into 
anyone else’s machine without first consulting one of your Technical Coordinators. 
 

 
For all others on campus, when your computer starts up, you will see the Novell Netware login box 

below. If you click on the Advanced button, you should see the following information: 
 

 
 

The Tree, Context and Server boxes should already be filled in with your appropriate information. 
Most faculty and staff log into the vutree with people.vu context (the server is usually blank, with 
the exception of some departments – ask your IT Coordinator if you are not sure). However, some 
departments log into different trees with different contexts. Ask your IT Coordinator or call the Help 
Desk (x97777) if you are having a problem connecting to the printers and shared folders that you 
normally use. Your Username should already be filled in. Simply type in your LDAP (email) 
password in the Password box and click OK. 
 
Once you have successfully logged in, wait for the Novell login scripts screen to run. This screen 
will close by itself. 
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For those using their laptops from home or off campus, you will not be able to log into Novell from off 
campus. Therefore, you can do one of two things: 

 
1. Click Workstation Only before logging in (those on the Arts & Science domain will not see 

this box). 
2. Login as you normally do and click Yes when you receive the message saying that The tree 

or server could not be found. Try logging into another tree or server. Would you still 
like to log into Windows? 

 
By answering Yes, you will still have access to email and the web via a modem connection (such as 
RAS or AOL), but you will not have access to any shared folders or printers on the Novell network.  
 

Once you are logged into your workstation, your personal settings are loaded and your desktop appears. 
These settings can be different for each individual who uses the computer. 

 
  

 
If more than one person uses your computer, each user must have 
his/her own account on the local workstation in order to gain access to 
the machine. Contact your IT Coordinator or call the Help Desk at 
x97777 for help in creating new user accounts on your machine. 

  

EXPLORING NEW WINDOW FEATURES 

 Discussion 
When you open a window, you will notice that the user interface is significantly changed. System 
and folder windows appear with a common tasks pane on the left side. This pane is context-sensitive; 
as you select objects in a window, the contents of the task pane change to reflect tasks that would be 
commonly performed with that object. Common task groups include System Tasks, File and Folder 
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Tasks, Picture Tasks and Network Tasks. Task groups can be collapsed to hide the listed tasks and 
expanded to display them. 
 
Other groups may also appear on the common tasks pane. The Other Places group contains links to 
other folders. For instance, you can open another folder, such as My Documents, by clicking the 
corresponding link. Selecting a link to another folder opens the folder in the current window. The 
Details group displays information about the currently selected object. 
 
Since most folder tasks appear in the tasks pane, Windows XP displays fewer buttons on the 
Standard Buttons toolbar. However, some buttons are especially useful. The Folders button 
alternates between the common tasks pane and the traditional Folders list. Since newly opened 
windows replace the current window, the Back and Forward buttons are useful for navigating to 
previously viewed windows. 
 

  

 
By default, the status bar is hidden, but you can display it by selecting the 
View menu and the Status Bar command. 

  

 
You can display navigational underscores on menus by pressing the [Alt] 
key. You can permanently enable navigational underscores by selecting 
the Appearance tab in the Display Properties dialog box, selecting 
Effects, and deselecting the Hide underlined letters for keyboard 
navigation until I press the Alt key option. 

  
 

 Procedures 

1. Open the desired window. 

2. To open another folder, select a link from the Other Places group on the common tasks 
pane. 

3. Select the desired file or folder to view the tasks in the common tasks pane. 

4. To hide the tasks in a group, click the up arrows in the task group. 

5. To display the tasks in a group, click the down arrows in the task group. 

6. Click the Folders button on the Standard Buttons toolbar to switch to the Folders list.  

7. Click the Folders button on the Standard Buttons toolbar to switch to the common 
tasks pane.  

8. To display a previously viewed window, click the Back or Forward button on the 
Standard Buttons toolbar. 

 



 

 

LESSON 2-  
CUSTOMIZING THE DESKTOP  
 

  

ADDING SHORTCUTS TO THE DESKTOP 

 Discussion 
When you first open Windows XP, you will immediately notice that the difference between this 
version and earlier versions of Windows is the appearance of the desktop. The most obvious change 
is that your icons will be different than they were on your old machine.  
 
You will see a shortcut to your My Documents folder, as well as ones for My Computer, My 
Network Places (formerly Network Neighborhood), Recycle Bin, Banner, Academic Audit (used 
by A&S), Netscape Messenger, Calendar and Communicator, and the Windows Backup 
program. 
 
You can easily add additional shortcuts to your Desktop for the programs that you use most often by 
following the procedures below. 

 Procedures 

1. Click the Start button and navigate up to Programs. Use your mouse to navigate, but do 
not hold the mouse button down. 

2. Locate the program that you want to create a shortcut for. 

3. With your right-mouse button, click on the name of the program. 

4. Navigate to Send To and then left-click on Desktop (create shortcut). 

5.  The shortcut will be placed on your Desktop. 

6. Hit the Esc key on your keyboard (top left corner) three times or click away from the Start 
menu to make the menu disappear. 

7. Repeat this process for all the shortcuts that you want on the Desktop. 
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DISPLAYING SYSTEM ICONS ON THE DESKTOP 

 Discussion 
The Recycle Bin, My Documents, My Computer, My Network Places, and the Internet Explorer 
icons have all been added to your desktop. However, if you remove these icons from your Desktop, 
you must go into the system’s display properties to restore them. 

 Procedures 

1. Open the Display Properties dialog box by right-clicking on your Desktop and 
selecting Properties.  

2. Select the Desktop tab. 

3. Select Customize Desktop. 

4. Select the icons you want to display under Desktop icons. 

5. Continue selecting options as desired. 

6. Select OK. 

7. Select OK or Apply. 

 
 
 

CHANGING YOUR DESKTOP AND DISPLAY SETTINGS 

 Discussion 
You may notice that the Desktop on your new PC looks different than that of your old computer. 
You may have had a green background or a photo as your Desktop background. Now you have a 
Villanova seal as your Desktop background. Other elements that have change are your screen saver, 
your color scheme, and possibly your display settings. You can change all of these features using the 
Display Properties dialog box, which controls the background and appearance of your desktop, the 
appearance of icons and screen savers, and settings for your monitor. The Themes page is new to the 
Windows XP display properties box. A theme is a set of display settings, including the Desktop 
background, the Screen Saver and the Appearance of all windows, buttons and bars in Windows. 
 
UnIT has created a theme for your new machine that is based on the Windows Classic theme. 
Although the Windows Classic theme looks and feels much like that of your old machine, it doesn’t 
take advantage of the many color and aesthetic enhancements that Microsoft has built into the 
Windows XP theme. You can easily switch to the new Windows XP theme, which is much more 



 

UNiversity Informational Technologies (UNIT) Page 7 
 

colorful, brighter and bolder than the Classic theme that you currently have. You can also customize 
your Desktop, Screen Saver and Appearance settings individually.  
 
The Desktop page, previously called the Background page, is used to select the desktop 
background. The Customize Desktop button opens the Desktop Items dialog box, where you can 
show, change or clean up desktop icons. The Web page, used to display, update, and control Web 
content on your desktop, is also located in this dialog box. If you want to use an image as your 
Desktop background, click the Browse button and select the file. 
 
The only change to the Screen Saver page is the method of password protecting your screen saver. 
You can enable password protection by selecting the On resume, display Welcome screen option. 
This will “lock” your machine once the screen saver comes on. Once your workstation is locked, 
only you (or another system administrator) can gain access to your machine by typing in a password. 
You can set the amount of time that you want your computer to wait before turning on the password-
protected screen saver. 
 
You can change the look of window elements with the Appearance page. You can select whether or 
not you want to use the Classic Windows or the Windows XP style in the Windows & Buttons 
section. This changes the appearance of all title bars, minimize/maximize/close buttons and the Start 
button. With both styles, you can change the Color Scheme and Font Size for windows and buttons.  
Using the Advanced button, you can change individual elements of a window. Selecting the Effects 
button provides options for changing transition effects and screen fonts. If you like to use the 
keyboard to select menu and dialog box items, you can deselect the Hide underlined letters for 
keyboard navigation until I press the Alt key option. 
 
The Settings page still allows you to change your screen resolution, which affects the size of the 
display of programs on your computer. The smaller the resolution, the less you will see of the “big 
picture.” For instance, when viewing a web page using a screen resolution of 800 x 600, you may not 
be able to see the entire page and will have to scroll right to see the entire contents of the webpage. 
However, if you change your Screen Resolution to 1024 x 768, you will be able to see most 
webpages in their entirety. Banner users may want to use the 800 x 600 resolution, while laptop users 
should stick with 1024 x 768. 
 
You can access the Display Properties dialog box by right-clicking on a blank area of your Desktop 
and left-clicking Properties.  
 

  

 
You can also open the Display Properties dialog box by opening the Control 
Panel and selecting Display (Classic View) or Appearance & Themes 
(Category View). 

  

 
If you are using a laptop or a flat monitor, you may want to turn on the 
ClearType feature to improve the visibility of screen fonts. You can enable 
this feature by selecting the Appearance tab in the Display Properties 
dialog box, selecting Effects, and selecting ClearType from the Use the 
following method to smooth edges of screen fonts option. 

  

 
It is a good idea to save the theme with another name to preserve your 
settings. 
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 Procedures 

1. Right-click on a blank area of your Desktop and select Properties. 

2. To change the Theme, select the Themes tab. To change to the new Windows XP 
Theme, select Windows XP from the Themes drop-down menu. 

3. To change the Desktop background, click the Desktop tab and select a different 
Background. To select a picture to be your Desktop background, click Browse 
and select the picture you want (you must know where that picture is). You must 
also determine how you want that picture to be positioned with the Position box. 
You can Center, Tile or Stretch the picture. 

4. To change the Screen Saver and its options, click the Screen Saver tab. To 
disable the Lock (password protect) feature of the screen saver, uncheck the On 
resume, password protect box. See important note box below about this. 

5. To change the Appearance of windows and buttons, click the Appearance tab. To 
switch to the new bolder and more colorful Windows XP appearance, change the 
Windows and Buttons from Windows Classic to Windows XP. With the 
Windows XP appearance, you can also change to from the Default (blue) Color 
Scheme to the Olive Green or Silver. The Windows Classic appearance of 
Windows and Buttons also gives your many Color Schemes to choose from. In 
addition, you have the ability to change the size of the Fonts on the title bars from 
Normal to Large or Extra Large. 

6. To change the size of your Display Settings, click the Settings tab and set it to 
either 800 x 600 or 1024 x 768. 

7. Select OK or Apply to save your settings. 

 
  

 
IMPORTANT NOTE: If you disable your screen saver altogether by 
selecting None on the Screen Saver list, you must click the Power button 
under Monitor Power on that same screen and tell the computer to Turn 
off the monitor after 20 minutes or so in order to prevent monitor burnout. 
Call the Helpdesk if you need assistance in doing this. 

  
 
 



 

 

LESSON 3 -  
USING NEW TASKBAR FEATURES  
 

CUSTOMIZING THE TASKBAR 

 Discussion 
You may notice a few changes to the Taskbar in Windows XP. The Taskbar is the long bar at the 
bottom of your screen where your Start button resides. The most obvious change is that the Taskbar 
is locked. When the taskbar is locked, you cannot move it or change its height.  
 
You can edit the Taskbar’s properties two ways: 1) By right-clicking on the Taskbar and selecting 
Properties; 2) By clicking Start, Settings, Taskbar and Start Menu and selecting the Taskbar tab 
at the top of the window. New customization options include: 
 

1. Lock the Taskbar, which prevents you from accidental resizing or moving the Taskbar. 
However, this feature also makes it so that you cannot resize the QuickLaunch Toolbar area, 
so if you want to add icons to the QuickLaunch toolbar and make them easily accessible, you 
must first Unlock the Taskbar. See note below about relocking the Taskbar. 

 
2. Group similar taskbar buttons, which will group applications that are open on the 

Taskbar. See “Using Grouped Taskbar Buttons” below for more information on this feature. 
 

3. Show the Quick Launch Toolbar, which is a shortcut bar directly to the right of your Start 
menu. You can drag shortcuts from your Desktop to the QuickLaunch Toolbar. To use a 
shortcut in the QuickLaunch toolbar, simply click once on the shortcut in the toolbar. This 
feature is helpful if you want to get to a shortcut on your Desktop, but you have other 
applications open. 

 
   

 
You can also right-click on the Taskbar to lock or unlock it or display toolbars. 

  

 
If the taskbar is locked, you cannot resize toolbars displayed on the taskbar, 
such as the QuickLaunch Toolbar. If toolbar icons are hidden, you must Unlock 
the Taskbar in order to resize the toolbar. To unlock the taskbar, right-click on 
the taskbar and click Unlock the Taskbar. Then drag the vertical line to the 
right of the QuickLaunch icons to resize the toolbar. It is recommended that you 
then right-click on the Taskbar and Lock the Taskbar again once you have 
resized the QuickLaunch Toolbar. This prevents you from accidentally 
resizing/moving the Taskbar and prevents the Taskbar from accidentally 
disappearing, which it sometimes will do. 

  

 
You can minimize all open windows by right-clicking the taskbar and selecting 
the Show the Desktop command. 
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Procedures 

1. Right-click the taskbar. 

2. Select the Properties command. 

3. To unlock the taskbar, clear the Lock the Taskbar box. 

4. Select OK. 

 

USING GROUPED TASKBAR BUTTONS 

 Discussion 
The taskbar displays a button for each open program. Many applications, such as Office XP, display 
a taskbar button for each open document as well. With all these buttons, the taskbar can become 
quite crowded. Windows XP solves this problem with a new feature that groups similar taskbar 
buttons under one button, when the taskbar becomes too crowded. For example, if you have 
Netscape Messenger and five Word documents open, Windows will group all the Word taskbar 
buttons together as one button. When you click the button, a list of all the open Word documents 
appears. To view a document, simply click the document name from the list. 
 
Grouped taskbar buttons display the common application name plus the number of open windows. A 
grouped button for six Word documents would display the button name, 5 Microsoft Word. A 
grouped taskbar button is also distinguished by a small white triangle on the right side of the button. 
 

  

 
You can turn off the taskbar grouping feature by right-clicking the taskbar, selecting 
Properties, and then deselecting the Group similar taskbar buttons option. 

  

 
If you disable grouping for taskbar buttons, the taskbar can display buttons for ten 
open windows. If you open more than ten windows, the taskbar adds another row 
and a scroll bar appears allowing you to scroll up and down the rows. If you prefer, 
you can also unlock the taskbar and increase its height so that all rows are displayed. 

  
 
 

 



 

 

LESSON 4 -  
EXPLORING CHANGES TO MY COMPUTER  
 

OPENING MY COMPUTER 

 Discussion 
My Computer, available from the Start menu, organizes all of your computer’s resources into one 
window. You can use My Computer to view and access any resources available to your computer, 
such as folders and files located on your hard drive, floppy disk drive, or any network drive to which 
you have access. 
 
When you open My Computer, the common tasks pane appears on the left side of the window. 
Initially, the pane contains three task groups. You can use the links in the System Tasks and Other 
Places groups to perform system functions or to open another folder. The Details group provides 
information about the selected object. If you select a storage device, such as a drive, you can see the 
amount of free space and the total capacity of the drive. 
 
Other changes to note in My Computer are that the icons are grouped under categories, the toolbar 
contains fewer buttons, and by default, the status bar does not appear at the bottom of the window. 
Categories in My Computer include Hard Disk Drives and Devices with Removable Storage. 
Other categories that may appear include: the Network Drives category if you are mapped to a 
network drive, and the Files Storage on This Computer category if your system is part of a 
workgroup rather than a domain. 
 

  

 
The first time you open the C:\Windows folders, you may have to click the Show the 
contents of this folder link to view the folder contents. 

  

 
Any Novell or ASDOMAIN network drives that you may have mapped, such as the F, 
H, M, O or S drives -  to name a few – will appear under the Network Drives area in 
My Computer. 

 

WORKING WITH NEW FOLDER VIEWS 

 Discussion 
When you open a folder, Windows XP senses the contents of the folder and automatically selects the 
appropriate view. There are several new views in Windows XP. 
 
The Thumbnails view is a new view to some versions of Windows. It is a view designed to preview 
graphics. If Windows XP recognizes the file format of a graphic, a miniature of the graphic appears 
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in this view. If Windows XP does not recognize the format, an icon representing the program 
associated with that file type appears in the thumbnail area. 
 
If you are working with a folder containing graphics, you can also use the Filmstrip view to view 
your pictures. This view is divided into two panes. The bottom pane displays all the images in the 
folder in thumbnail size across one row, as if in a filmstrip. The top pane displays the selected 
picture in magnified size. This view also includes tools to navigate through your pictures and rotate 
them. 
 
The default view for most folders is the Tiles view. In addition to displaying the file or folder name, 
this view shows additional information, such as file type, size, or author. You can switch to other 
views, including Thumbnails, Icons, Details, List, and Filmstrip (only available in those folders 
containing pictures). To change to another folder view, you can select the desired view from the 
View menu or you can click the down arrow to the right of the Views icon on the Standard Buttons 
toolbar.  
 

  

 
You may need to refresh a view in order to access the Filmstrip view. 

  

 
The Large Icons view in previous versions of Windows is now called Icons view. 
The Small Icons view is no longer available and the List view has not changed. 

 Procedures 

1. In My Computer, open the folder whose view you want to change. 

2. Click the Views button  on the Standard Buttons toolbar and try the various views 
on the menu to see which you like best. The view that shows you the most about your files 
and folders is the Details view. 

3. Changing the View will only affect the view of this folder. If you want all of your folders 
to have the same view, see the “Changing Folder Options” section below. 

 
 

CHANGING FOLDER OPTIONS 

 Discussion 
You can use the Folder Options dialog box to change the look of all your folders. You can select 
settings that affect all folders, or apply the view of the current folder to all folders. 
 
Options selected on the View page apply to all folders. These options include controlling the display 
of file extensions, hidden and system files, and pop-up descriptions. You can try enabling and 
disabling different options to see which settings you prefer. 
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By default, an icon view selected from the View menu only affects the current folder. If you decide 
to display all your folders with the same view settings, you can use the Apply to All Folders button 
in the Folder Options dialog box to apply these settings to all folders. The Reset All Folders button 
resets the view for all folders back to the default. 
 
You can use the General page to display the Windows classic folders, which displays folders 
without the common tasks pane. You can change options to open each folder in its own window 
while browsing, instead of using the same window, and open items with a single-click instead of a 
double-click. 
 
The Restore Defaults button on each page allows you to reset the options to their default settings. 
 

  

 
Users often select single-clicking to eliminate the confusion that arises from single-
clicking hyperlinks and double-clicking Windows icons. 

  

 
When single-clicking is enabled, you select an item by pointing to it. You can select 
multiple items by holding the [Shift] or [Ctrl] keys and pointing to the desired 
items. 

  

 Procedures 

1. Open My Computer. 

2. Select the Tools menu. 

3. Select the Folder Options command. 

4. Select the View tab. 

5. Select or deselect the desired options. If you want all of your folders in Windows to 
show in the View that you have selected for the current folder that is open, click Apply 
to All Folders. 

6. Select the General tab. 

7. Select the desired options under the Tasks, Browse folders, and Click items as follows 
sections. 

8. Select OK to save your changes and close the Folder Options dialog box, or select Apply 
to apply your changes and leave the dialog box open. 

 

 
When you change the View of all folders (i.e., to Details view), you can override 
that view for any individual folder by clicking on the Views button  on the 
Standard Buttons toolbar and selecting a different view. You may want to do this 
if you have changed all of your folders to the List or Details view, but your want 
your folders that contain pictures to display in the Filmstrip view. 



 

 

LESSON 5 -  
USING NEW FILE AND FOLDER FEATURES  
 

USING COMMON FILE TASKS 

 Discussion 
The common tasks pane is a new feature in Windows XP. When you open a folder or select a file, 
Windows displays all the tasks you would commonly perform on the selected item. Tasks pertaining 
to files and folders appear in the File and Folder Tasks group. These tasks include renaming, 
moving, copying, publishing, e-mailing, printing, and deleting the file. 
 
Folder toolbars no longer contain buttons for cutting, copying and pasting. Although you can still use 
the Edit menu or keyboard to perform this two-step process (cut/copy and paste), Windows now 
includes a one-step process for moving and copying files. The Move this file and Copy this file 
tasks both open dialog boxes that allow you to select the destination from a folder tree. In addition, 
you can create a new folder during the process. If you are moving or copying multiple files, the name 
of the task changes to Move the selected items and Copy the selected items. 
 
While the common tasks pane makes it easy to perform tasks in a folder, the Folders list is a good 
way to navigate to a desired folder. You can use the Folders button on the Standard Buttons 
toolbar to switch between the common tasks pane and the Folders list. 
 

  

 
My Computer and Windows Explorer are the same program in Windows XP. My 
Computer opens with the common tasks pane displayed and Windows Explorer 
opens with the Folders list displayed. No matter which you open, you can use the 
Folders button to switch between panes. 

  

 
File tasks are also located on the File and Edit menus. 

  

 
New folders created in the Move Items and Copy Items dialog boxes are 
automatically named New Folder. You can rename the folder before you complete 
the move/copy process or after the process is complete. To rename the folder while 
in the dialog box, select the New Folder folder, press the [F2] key, type a new 
name, and press [Enter]. 

 Procedures 

1. In My Computer, open the desired folder and display the common tasks pane - if it is not 
already visible - by clicking the Folders button. 

2. Select the file on which you want to perform a task. 
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3. To move or copy the selected file, select the Move this file or Copy this file tasks under 
the File and Folder Tasks group. Select the drive where you want to move or copy the 
file. Select the folder where you want to move or copy the file. To create a new folder, 
select Make New Folder. Select the desired folder. Select Move or Copy. 

4. To email the selected file, click Email this file. Netscape Messenger will open up a new 
Composition window and the file will be attached. This will not work if you are using 
WebMail. 

5. To print the selected file without opening it, click Print this file. The file will be printed 
to your default printer. 

6. To delete the selected file, click Delete this file. You will be asked if you are sure. Click 
Yes to delete the file and Cancel to cancel the deletion. The deleted file will be moved to 
your Recycle Bin. 

 
  

 
You can select more than one file to perform a task on by holding the [Ctrl] key and 
pointing to the desired items. To select an entire string of files, click on the first one, 
hold the [Shift] key and click on the last one. To select all of the files within a 
folder, open the folder, then click on Edit from the menubar above and clicking on 
Select All or by clicking [Ctrl] – A on your keyboard. 

  
 

USING COMMON FOLDER TASKS 

 Discussion 
Windows XP senses when a folder is selected and displays folder-related tasks in the common tasks 
pane. Common tasks that appear in the File and Folder Tasks group include renaming, moving, 
copying, publishing, sharing, e-mailing, and deleting the folder. You move and copy folders using 
the same procedures for moving and copying files. 
 
You can use the Make a new folder task to create a new folder. However, you must deselect all 
folder items to access this task. 
 

  

 
You can also access the common tasks pane in Windows Explorer by selecting the 
Folders button on the toolbar. 

  

 
Folder tasks are also located on the File and Edit menus. 
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 Procedures 

1. In My Computer, select the folder on which you want to perform a task. 

2. Select the desired task from the File and Folders Tasks group, such as Rename this 
folder, Move this folder or Copy this folder. 

3. To create a new folder, deselect any selected folder items. Click the Make a new folder 
task in the File and Folders Tasks group. Type a name for the folder. Press [Enter]. 

4. To copy or move a folder, select the folder you want to move or copy. Select the Move 
this folder or Copy this folder. Select the drive where you want to move or copy the 
folder. Select the folder where you want to move or copy the file. To create a new folder, 
select Make New Folder. Select the desired folder. Select Move or Copy. 

5. To email the selected folder, click Email this folder. Netscape Messenger will open up a 
new Composition window and the files within that folder will be attached. This will not 
work if you are using WebMail. 

6. To delete the selected folder, click Delete this folder. You will be asked if you are sure. 
Click Yes to delete the file and Cancel to cancel the deletion. The deleted file will be 
moved to your Recycle Bin. 

 
 



 

 

LESSON 6 -  
USING THE SEARCH COMPANION  
 

SEARCHING FOR FILES AND FOLDERS 

 Discussion 
The search function in Windows XP is called the Search Companion. Although similar in function to 
the Find or Search commands in previous versions of Windows, the Windows XP Search 
Companion includes many more search options. 
 
Selecting the Search command on the Start menu opens the Search Results window, with the 
Search Companion displayed in the left pane. The Search Companion is where you enter your 
criteria to search for files and folders. After performing a search, the right pane lists the search 
results. You can open a found file or folder from the right pane simply by double-clicking it. 
 
The first step is to select the type of item for which you are searching. You can search for media 
files, such as pictures, music and video; documents, such as those created with word processing and 
spreadsheet programs; or all files and folders. In addition, you can search for other computers on 
your network, or for people in your address book or an Internet directory. 
 
Search options are context-sensitive. Windows displays different search fields depending upon the 
type of item you are searching for. 
 
After the found files appear in the Search Results window, you have three choices. If you are 
satisfied with the results, you can select Yes, finished searching. This closes the Search Companion, 
but leaves the Search Results window open with the found files listed. If you are not satisfied with 
the results, you can use the links under No, refine this search and... to change your search criteria. 
Finally, if you want to conduct another search, you can select Start a new search. 
 

  

 
You can also access the Search Companion from a folder window by clicking the 
Search button on the Standard Buttons toolbar. The results of your search will 
then appear in the Search Results window. 

  

 
Selecting the Start a new search link does not clear the previous search criteria. 
The search criteria is not cleared until you close the Search Companion.  

  

 
You can save your search criteria in a file using the File menu and the Save Search 
command. To reuse the search, double-click the saved search file to open your 
criteria in the Search Companion. Then, select Search to perform the search. 
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 Procedures 

1. To open the Search Companion, click on Start, Search, for Files or Folders. Make sure 
your window is maximized by clicking on the Maximize button at the top right corner of 
the window. 

2. Select the desired type of search (select Documents for any file that is not a system file). 

3. If you know when the file was last saved, select the desired date option. If you don’t 
remember, leave Don’t remember selected. 

4. To search for files or folders with a specific name, type the name of the file or folder you 
want to locate. If you don’t know the exact name of the file, type part of the filename in the 
box. 

5. Select Search to perform the search. 
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LESSON 7 -  
USING THE HELP AND SUPPORT CENTER  
 

EXPLORING THE HELP AND SUPPORT CENTER 

 Discussion 
The process of getting help in Windows XP has been greatly expanded. Help is now located in the 
Help and Support Center, which provides a colorful, full-blown support system. 
 
The home page for the Help and Support Center includes a navigation bar (toolbar), a Search box, 
and links to information arranged under categories. Major topic headings are listed under the Pick a 
Help topic category. You can select a link and drill down until you find the desired information. 
 
Other categories appear on the right side of the Help and Support Center window. These include Dell 
Online, Additional Resources, and Did you know? categories. Links under these categories open 
specific help pages.  
 
Note: If you have a hardware or software problem, please contact the Helpdesk at x97777. Do not 
call or email Dell. 
 
Selecting a link under one of the categories opens a two-pane window. On the left is the navigation 
pane, which displays topic and subtopic headings. On the right is the topic pane, which displays help 
information or links to other help topics. A toolbar appears above the topic pane. You can use the 
Change View button to display only the topic pane so that you can view your desktop and the help 
information at the same time. The Print button prints the current topic in the topic pane. 
 
As you move through the help windows, you can use the buttons on the navigation bar to navigate to 
previously viewed windows. You can always return to the opening Help and Support Center page by 
clicking the Home button on the navigation bar. 
 

  

 
The Help and Support Center can also be opened from any folder window by 
selecting the Help menu and the Help and Support Center command. 

  

 
Some links require an Internet connection to find information. Most of the links 
under the Did you know? category are Internet based. 

  

 
To print all the subtopics under a topic heading, right-click the heading in the 
navigation pane and select Print. A dialog box opens describing your print 
selection. You can also print pop-up descriptions in a dialog box by right-
clicking the pop-up box and selecting the Print Topic command. 
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 Procedures 

1. Select the Start button on the taskbar. 

2. Select Help and Support. 

3. Select the desired link. 

4. To expand a topic in the navigation pane, click the plus sign. 

5. Click a subtopic in the navigation pane. 

6. Continue expanding links in the topic pane until the desired information appears. 

7. Click the  Change View button to display only the topic pane. 

8. Click the  Change View button to display the entire Help and Support Center 
window.  

9. Click the Home button  on the navigation bar to return to the home page. 

 

SEARCHING FOR HELP TOPICS 

 Discussion 
You can use the Search box on the Help and Support Center home page to search for information 
about a topic. You should enter one or more words related to the topic you want to find. The topics 
that match your search words appear in the Search Results pane. 
 
Search results are displayed in categories. Help topics contain a list of keywords to speed up 
searching. The topics listed in the Suggested Topics category have keywords that match your search 
text and provide the closest match to your criteria. Topics listed under the Full-text Search Matches 
category contain some of your search words in the topic text, but since they do not contain matching 
keywords, they may not be as relevant to the information for which you are looking. 
 
With an Internet connection, you can also use the Microsoft Knowledge Base category to search 
Microsoft’s online store of information. 
 
If your search produces too many results, you can narrow the search by selecting the Search within 
previous results option and entering more specific text in the Search box. 
 

  

 
You should only enter the specific words related to the topic in the Search box, 
not full sentences or questions. 
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 Procedures 

1. Open the Help and Support Center. 

2. Click in or select the current text in the Search box. 

3. Enter words relating to the information you want to search for. 

4. Press [Enter] or click the Start searching arrow. 

5. Click a link under the Suggested Topics category. 

6. To view other matches, click Full-text Matches or Microsoft Knowledge Base in 
the Search Results pane. 

 

CHANGING SEARCH OPTIONS 

 Discussion 
Settings in the Set search options page affect the number of search results found. You can adjust the 
options to find more or fewer matches. 
 
For Full-text Search Matches, you can narrow the search to match words in titles only, or broaden 
the search to match similar words. Furthermore, you can omit search categories completely from a 
search. For example, if you want to search keywords only, you can leave only the Suggested Topics 
category enabled. 
 
If you are conducting an online search, you can change the options for the Microsoft Knowledge 
Base category. You can limit the search to titles only, select a product to search, and select how 
search words are matched. 
 

  

 
You can also open the Set search options page by clicking the Options button 
in the navigation bar and selecting Set search options in the navigation pane. 

 

USING FAVORITES AND HISTORY LISTS 

 Discussion 
The Help and Support Center employs several tools that you can use to return to topics that you 
previously viewed. 
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The Favorites list is used to bookmark help topics you want to easily find again. Once you find a 
topic you would like to bookmark, you use the Add to Favorites button on the topics pane toolbar to 
add it to the Help and Support Favorites list.  
 
When you want to view the Favorites list, you select the Favorites button on the navigation bar. You 
can then redisplay any bookmarked topic. In addition to displaying topics, you can also rename them 
and remove them from the list. 
 
The History list is another way of locating a help topic you previously viewed. Every topic you have 
viewed appears in the History list in the order in which they were viewed. You can use the History 
button on the navigation bar to open the History list and select a topic to redisplay. 
 

  

 
The Help and Support Favorites list is not the same Favorites list found in 
Internet Explorer or in a folder window. 

  
 
 

CHANGING HELP OPTIONS 

 Discussion 
You can customize various Help and Support Center options using the Options button on the 
navigation bar. 
 
You can use the Change Help and Support Center options link to modify the icons that appear on 
the navigation bar and change the size of the font used for content in topic pane. 
 
Other links in the Options pane include Set search options to modify search settings and Install and 
share Windows Help to install other Help content and share the content with other users on your 
network. 
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LESSON 8 -  
SHUTTING DOWN/LOCKING YOUR WORKSTATION  
 

SHUTTING DOWN YOUR COMPUTER VS. LOCKING THE 
WORKSTATION 

 Discussion 
Most of us are used to shutting down our computers at the end of the day. However, there is no 
longer a need to shut your new computer down every day. To secure your system, all you need to do 
is Lock the Workstation at the end of the day. When you come back in the morning, simply type in 
your password and the machine will come right back to where you left it the day before. 
 
It is a good idea to periodically shut your computer down (around 2 times a week and on the 
weekends), but not daily. 

 Procedures 

1. To lock your workstation, hit the Ctrl-Alt-Delete key combination on your keyboard. 

2. Click Lock Workstation. The workstation will be locked, preventing anyone (except a 
system administrator) from getting into your computer. 

3. When you come back to your computer, type your user password to get back into the 
computer. 

 
1. To shut down your computer, click the Start button and select Shut 

Down.  

2. Click OK. 

 
Other options on the Shut Down Windows menu are: 

 
1. Logoff – Log out of the current user account so that another user can login 
2. Restart – Reboots the computer 
3. Stand by – Maintains your session, leaving the computer running with low power with data 

still in memory. 
 

  

 
Whatever option you select from the Shut Down menu will be 
the default option the next time you click on Shut Down. 
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LESSON 9 -  
OTHER WINDOWS FEATURES 
 

ENDING A PROGRAM THAT IS NOT RESPONDING 

 Discussion 
Windows XP is a much more secure operating system than Windows 98. You will notice 
fewer “Illegal operations” and will find that your new computer is much more stable than 
the old one. Even when a program “crashes,” Windows XP will often close that 
application without forcing you to restart the computer. In addition, better document 
recovery has been built into the Microsoft Office applications, so when Word, 
PowerPoint or another Office program experiences a problem, the program will close, 
reopen and recover your work as best as it can (see the Word, Excel and PowerPoint 
documentation to learn about document recovery). 
 
Sometimes, however, a program will stop responding but will not tell you. You can 
manually end the program that is not responding so that you can continue on with your 
work. To do this, you must enter the Task Manager. The Applications tab of the Task 
Manager lists all open applications and lists the status of each program, including 
Running or Not Responding. 
 
Once in the Task Manager, to end a program that is not responding, select the program 
from the list and click the End Task button. You may get a message saying that the 
program is not responding. When you click End Task again, the program will close. 
Unlike the Windows 98 task list, you must close the Windows XP Task Manager by 
clicking on the X at the top of the window. 

 

 Procedures 

1. Hit the Ctrl-Alt-Delete key combination on your keyboard. 

2. Click the Task List button. 

3. Select the Applications tab if it is not already selected. 

4. Select the application that is not responding and click End Task. 

5. If necessary, click End Task again if prompted to do so. 

6. Close the Task Manager by clicking the X in the top right corner. 
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CREATING USER ACCOUNTS 
 

 Discussion 
Because Windows XP is a secure operating system, every person who uses your computer must have 
his/her own account. User Accounts can be set up two ways: as Administrators or as Limited Users. 
Limited Users do not have the ability to edit User Accounts or install/remove hardware and software.  
They also cannot access your My Documents folder. Administrators have the ability to do everything 
that you can do on the machine, including add/remove software and hardware, add/remove User 
Accounts (including yours) and view all folders, including your My Documents folder. 
 
Because of the sensitivity of creating User Accounts, we ask that you please call the Helpdesk or 
your IT Coordinator for assistance in creating them.
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